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Installation Planning Guide

Autodesk® Inventor® provides a comprehensive set of design tools for the development,
validation, and documentation of manufactured products. It is used in a wide range of
industries. Installations of Autodesk Inventor 2011 range from single computers for
independent contractors to large multi-site installations supporting hundreds of engineers
and designers.

This guide reviews the many different usage scenarios, which can be installed in different
configurations.

Purpose

Use this guide to help you make the appropriate decisions concerning the
installation and deployment of Autodesk Inventor 2011 for your specific product
design environment. Whether this installation is your first of Autodesk Inventor
or an upgrade from a previous version, this planning information ensures an
expeditious and successful deployment.

This guide is meant as an overview. For further information about each topic
see “Other Sources of Information” at the end of each section.

If after reading this guide you need additional guidance to plan your installation,
we recommend that you contact your reseller.

Other Sources of Information

Read the Fundamentals for the Inventor CAD Manager resource guide for information
about best practices, installation, migration, Application Options settings,
configuring styles, and so on. This guide provides links to existing content in
the Help, white papers, installation Help, and many other sources.



Locations:

B On the product media, installation wizard, click Read the Documentation.
Under Autodesk Inventor 2011, click Fundamentals for the Inventor CAD
Manager.

B [n the product Help, Contents tab, click CAD Manager Fundamentals.
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License Types and Usage

This chapter explains some of the installation options for both Stand-alone and Network
licenses for your Autodesk® Inventor® 2011 product. It also guides you to other sources of
detailed information.

NOTE Requirements and recommendations are covered in Recommended System
Requirements on page 17.

Stand-alone License

A stand-alone license is typically for home use, and for independent contractors
and small teams with limited network access.

You can install a stand-alone license directly from the product media, or create
a deployment image for installation. You can register at the time of installation.

Network License

NOTE Autodesk Inventor LT 2011 does not support network license management.
This section applies only to the AutoCAD® Inventor® suites and Autodesk Inventor.

Members of a team who are connected to a corporate network typically use a
network license. You can use a single-license server or multiple servers to provide
additional redundancy.

When you have a Network License:

B You can do a multi-seat installation from the product media for stand-alone
licenses or network licenses, or any mix.



B Team members are not required to register. The Network License Manager
manages requests for running networked applications.
For example, say that you purchased a network license for 25 seats, and
the product is installed on 30 seats within the network. The Network
License Manager is installed, activated, configured, and started on an
appropriate server. Then up to 25 of the 30 installed systems can log on
at any given time. When someone closes an application, it becomes
available to the next system that logs on.

B You can also install a network license for Autodesk Inventor or Mechanical
product directly from the media.

B The registration information is pre-configured during creation of the
deployment image and is duplicated for installations on all workstations.

Multi-seat Stand-alone Installation

You can install a multi-seat stand-alone configuration directly from the media,
or create a deployment image for installation with a network license.

When you set up a multi-seat stand-alone installation:

B To install on workstations requires that you use the shortcuts provided in
the deployment image created by the Deployment wizard. The registration
information is pre-configured during creation of the deployment image
and is duplicated for installations on all workstations.

B The products can be installed on only the maximum number of systems
the license allows, except for 30-day trial versions.

m All deployment images require the same serial number for activation, and
they are all activated the first time a product is launched.

Network License Server Models

The network license server is the location where the Network License Manager
is installed. You can use a single-license server or multiple servers to provide
additional redundancy:

Single The Network License Manager is installed on a single server. License
management and activity is restricted to this server. A single license file
represents the total number of licenses available on the server.

4 | Chapter 2 License Types and Usage



Distributed Licenses are distributed across more than one server. A unique
license file is required for each server. To create a distributed license server,
you run the Network License Manager on each server in a distributed pool.
Each server serves a subset of the total license pool.

Redundant The Network License Manager is installed on each of three servers
to authenticate a single license file. One server acts as the master. If the master
server fails, the other two provide backup. Licenses are monitored and issued
as long as at least two servers are functional.

Requirements for Network License Servers
Operating System:
B Windows server® 2003
m Windows® XP Professional Service Pack 1, 2, or 3
B Windows server® Edition
m Windows® 2000 Service Pack 4

B Windows® Vista™ Service Pack 1

Computer:

B Intel® Pentium® III or equivalent with at least 450-MHz processor and
Network Interface Card TCP/IP

NOTE It is possible to run a Network License Server on a workstation. However,
if the workstation is sometimes turned off, we recommend that you run the
Network License Server on a dedicated server to avoid possible work stoppages.

Cascading Licenses

Cascading licenses is a feature of the Autodesk® Network License Manager.
Its purpose is to assign appropriate licenses when different Autodesk products
are installed on the same network. When a product starts, it requests a
matching license from the license server. If the matching licenses are all in
use at the time of the request, then the cascading license feature looks for a
higher value license. The license request is then satisfied, and there is no work

stoppage.

Requirements for Network License Servers | 5



If a specific team member needs access to only one specific application (for
example, Autodesk Inventor), then you install only that application on that
member computer. The installation participates in the complete license pool.

Instruct teams to close Inventor when they finish using it so that the license
is availabel for someone else. Licenses are returned to the license pool when
the application closes.

For more information about cascading licenses:

m Search the Autodesk® Knowledge Base with the keywords “cascading
licenses”.

B On the install media, on the first page of the Installation Wizard, click
Read the Documentation, and refer to the License Guide.

License Multiple Autodesk Products

To manage license files for more than one Autodesk product, you combine
them. To combine license files for Autodesk products, you add lines from the
new license file to the existing license file.

See Other Sources of Information on page 7.

Configure Autodesk and Vendor Products

You can configure the FlexNET® license manager to provide network licenses
for Autodesk and other vendor products from one server. It is required that
you have only one installation of FlexNET on a given server. We recommend
that you create a separate service for each vendor.

Borrow Licenses

If you take work to another location, you can transfer, or borrow a license. A
borrowed license means you can use an Autodesk product on more than one
computer without purchasing a separate license for each computer. To borrow
a stand-alone license, use the License Transfer Utility to transfer the license
from a particular system to another.

If you Autodesk Inventor software with a network-license, you can borrow a
license from a license server for a specified time of up to 180 days. You can
use the program while your computer is not connected to the network. You
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can give the license back to the server any time before the end of the specified
borrowing time. You must be connected to your Network to borrow the license
from Inventor. To borrow a license on a network, on the Start menu, click
Programs » Autodesk » Autodesk Inventor [version] » License Transfer
Utility.

License Timeout Feature

With license timeout, you can set a timeout period on your license server.
Then a license returns to the license server when:

B A connection with the workstation is lost.

B A license is checked out but the Autodesk product is idle on a workstation
for longer than the timeout period you define.

See Other Sources of Information on page 7.

Transfer Stand-alone Licenses

The Portable License Utility transfers a product license from one computer to
another. It ensures that the product works only on the computer that currently
contains the license. There is a grace period of 24 hours for an emergency time
period with a portable license.

Other Sources of Information

For more information about the license timeout feature and how to set the
timeout parameters, on your product media, documentation page, see Network
and Licensing » Network Licensing Guide » Set Up License Timeout.

For more information about requirements for network server licenses, see the
Network Licensing Guide and the Autodesk Vault 2011 Implementation Guide on
your product media.

Use the Search function on the Autodesk Web page to search for more
information about combining licenses.

1 On the Web, Go to http://www.autodesk.com » Industries »
Manufacturing.

2 In the Search box, enter TS65928, and then click >.
Topics about combining licenses are listed.

Transfer Stand-alone Licenses | 7
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Click a topic title to view the content.

Use the same procedure to search for other topics, including the following:

Enter in Search  For information about

TS67745 Configure Autodesk and vendor products.
TS74980 Additional license configurations.

cascading licenses  Additional information about cascading licenses.

Autodesk Knowledge Base

Use the Autodesk Inventor knowledge base to search for more information
about borrowing licenses:

1 On the Web, go to http://www.autodesk.com » Products » Autodesk
Inventor » Service and Support.

2 Click Knowledge Base Search.

3 In the Search box, enter borrow licenses, and then click Search.
Topics about borrowing licenses are listed.

Click a topic title to view the content.

Use the same procedure to search the Knowledge Base for other topics,
including the following:

Enter in Search For information about

TS65935 FLEXIm feature codes for Autodesk applications.

cascading license  Additional information about cascading licenses.

8| Chapter 2 License Types and Usage
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Content Center

The Autodesk® Inventor® Content Center provides access to an extensive library of parts,
such as fasteners, steel shapes, and fittings. You can use these components in designs. This
chapter describes the configuration requirements for Content Center, and includes a guide
to more detailed information about it.

Content Center Configurations

The data stored in Content Center is organized and published with functional
intelligence. For example, it includes additional parameters and properties
utilized by Design Accelerator and Autodesk® Inventor® Professional tools to
guide, create, and validate design. Frame Generator in Inventor 2009, 2010, and
2011 also uses Content Center libraries. You can use the Content Center Favorites
tool located in the browser bar to search, edit, and organize content in groups
for quick access.

During the Inventor installation, in the Content Center Access Options, you
determine which solution to install:

B Inventor Desktop Content for standalone users. Desktop Content and
Desktop content libraries are installed by default by the product installer.

B Autodesk Vault server for multiple users who wish to share content, or larger
installations. Install separately the Vault server and Content Center libraries
for Vault server.

You deploy the Vault server with Content Center as a centralized content
repository. You can customize the content data, such as part number and
descriptions, based on company preferences to ensure designers work with the
same approved data.



To set up Content Center, use a centralized server for all users if you customize
the content data for your site or modify it over time. Although it increases
network traffic, storage costs decrease.

Install Versions 2011 and 2010 Side-by-side

You can run Autodesk Inventor 2011 and Autodesk Inventor 2010 software
on the same desktop workstation, with each accessing the appropriate Content
Center data. A single data management server provides and supports versions
2011 and 2010 content. The server can be installed on the same workstation
as Autodesk Inventor versions 2011 and 2010 software.

Important points about side-by-side installation

B Versions 2010 and 2011 both access the same server — Autodesk® Vault
2011 server.

B To use Autodesk Inventor 2010 Content Center with the Autodesk Vault
2011 server, install the Inventor Upgrade for Autodesk Vault server. This
upgrade is available as a download only. It also upgrades the Vault client.

B Autodesk Vault 2011 server supports content for different Inventor versions.

For more information about this installation process, see the white paper
Content Center for Inventor 2011 Side-by-side Installation on the product media.

Optimize Hard Disc Or Drive Space

The Content Center database is extensive. It covers 18 international standards
with over 750,000 components. The hard disc or drive space requirement is:

B Desktop Content solution for a single user: up to 7 GB.

B Vault server solution for workgroups: up to 1.3 GB.

You can install only the libraries you need initially. At any later time, you can
add more libraries through the installer.

Set Up a Local Content Center

If you are a single user or an independent member of a design workgroup,
and you do not plan to share content libraries, install Desktop Content. Select
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the Content Center libraries to install on the local machine. This sets up
Content Center on the same machine with Autodesk Inventor.
Data Access for Local Content Installation

The Autodesk Vault 2011 server supports the Web server Microsoft® Internet
Information Services (IIS) for all multi-user installations.

For more details, and procedures for installing this server, refer to the Autodesk
Vault 2011 Implementation Guide on your product media.

Set Up a Shared Content Server

We recommend that workgroups share a common Content Center located on
a networked server. For example,

\\Workgroupserver\ Engineering\Content_Center_Files. A common Content Center
facilitates resolving links to components from Content Center when different
workgroup members load assemblies.

Workgroup members can also install Desktop Content libraries on their local
machines. Then they can switch between Desktop Content and Autodesk
Vault Server in Application Options » Content Center » Access Options.

Requirements for Shared Servers
B Approximately 1.3 GB of hard drive space for installation.

B Temp space of an additional three times the requirement for installation
or maintenance operations on the database.

Autodesk Vault Server

The Autodesk Vault server is used to manage Content Center file and version
data. It is required that you install the Vault server on the same computer
with the Content Center libraries you plan to access.

The requirements for installation of the Vault server software are in addition
to the system requirements for individual applications.

Set Up a Shared Content Server | 11



Other Sources of Information

See the Autodesk Vault 2011 Implementation Guide on the documentation page
on your product media for more information about:

B System requirements, supported operating systems, and supported databases
for Autodesk Vault server

B Installing and upgrading the Vault server
B Additional hardware specifications and system requirements

B Requirements for SQL Server support

For more information about installing the Content Center, see:

B Autodesk Inventor 2011 Content Center Standalone User Guide on the product
media.

B Autodesk Inventor 2011 Content Center Installation Guide on the product
media.

12 | Chapter 3 Content Center



Autodesk Vault Products

The Autodesk data management tools include Autodesk® Vault 2011 and several other
components. There are several configurations to consider in your plan for installation,
depending upon your particular needs.

Implementation Guide for 2011

The Autodesk Vault 2011 Implementation Guide is located on the documentation
page on your product media in PDF format. We recommend that you read this
guide to gain an understanding of the data management tools and components
before you begin to install them. You also learn to tune Vault for performance,
and to run diagnostic tools to troubleshoot.

If you are a first-time user, the Implementation Guide provides essential information
about:

B Backing up data in a Vault

B Vault architecture and components

B Installation, operating system, hardware, and other requirements

B Configurations for single and multiple users, multiple sites, and remote SQL

B DPre-installation checks

Before you upgrade from a previous version, review the Implementation Guide. It
provides checklists of some of the major areas to consider before you move to
a new release:

B Hardware and software requirements

B Business requirements

13



W Testing

B Migration

Other Sources of Information

For more information, see the Autodesk® Knowledge Base.

1 On the Web, go to http://www.autodesk.com/inventor » Services &
Support.

2 Click Knowledge Base.

3 In the Search box, enter a topic, and then click >.
Click a topic title to view the content.

Refer to the ongoing Autodesk discussion group at
http://www.autodesk.com/inventor » Products » Services & Support »
Discussion Groups » Autodesk Vault.

14 | Chapter 4 Autodesk Vault Products



Installation Process

This chapter helps you familiarize yourself with the installation process before you begin to
install Autodesk®Inventor® products. It describes:

B Installation prerequisites
B System requirements

B The interface of the installation wizard

It provides information to help you configure your particular installation.

When the installation is complete, register and activate your products. For more information
about registration and activation, see License Types and Usage on page 3.

Installation Interface

You can install products, create a deployment of a single or multiple Inventor
products, and install tools and utilities through a single dialog box.

Each page in the Installation wizard contains a task section and an information
section. To aid in the decisions required during installation, the information
section contains links to information that is pertinent to the contents of the
task section. As you proceed from page to page in the wizard, the list in the
information section changes according to the contents of the task section.

After you select your products, a page with a summary of your selections is
provided along with explanations of what the selections mean. You can back
up and change the selections.

There are two links at the bottom of every page of the installation wizard:

B Documentation: Installation guides, network guide, licensing guide, and
resource guide for the Inventor CAD manager, in PDF format.
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B Support: Links to the Autodesk® support pages on the Web.

Prerequisites

Before you begin to install the software, we recommended that you review

and meet the prerequisites:

B Administrative privileges. Obtain administrative privileges on each
workstation where you plan to install the products. If you are unsure of
your permission level, see your system administrator for more information.

m Distribution plan. For network installations, create a distribution plan for
installing the products on clients once they are installed on the primary

system.

B Other applications. Close all other applications, and temporarily disable
virus checking utilities. The installation process could stop if some
applications, such as Microsoft® Outlook® or virus-checking programs, are

running.

B Product license. Understand the product licenses you ordered. See License

Types and Usage on page 3.

Autodesk Inventor 2011 Application

Inventor 2011 is available on product media or, in some situations, electronic

download.

Application

Autodesk Inventor 2011 32-bit
Autodesk Inventor 2011 64-bit
AutoCAD® Mechanical 2011 32-bit
AutoCAD Mechanical 2011 64-bit

Autodesk® Vault Explorer 2011 32-bit

16 | Chapter 5 Installation Process
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Language requirements

B Autodesk Inventor and AutoCAD Mechanical design applications and
Autodesk Vault products must all be the same language on a given
computer.

B You can run English versions of these applications on operating systems
of any language.

B While you create a deployment image, you can select multiple languages.

Recommended System Requirements

Before you begin installing, check to see that your system meets the
recommended hardware and software requirements. Also, ensure that you
have the system settings required to install and run Autodesk Inventor 2011.

Whether your Windows operating system is the 32-bit or the 64-bit version,
the version is automatically detected during installation. The appropriate
version of is installed. A 64-bit version of cannot be installed on a 32-bit system
and vice-versa.

For Windows Users: See the following table for hardware and software
requirements.

Recommended

Microsoft Windows®
Operating Systems

Processor

RAM

For part and assembly design (less
than 1,000 parts)

Windows® 7 (32-bit or 64-bit); Home
Premium, Professional, Ultimate/Enter-
prise

Windows® Vista™ (SP2) (32-bit or 64-
bit): Home Basic, Home Premium,
Business, Enterprise, Ultimate
Windows® XP: Professional (SP3)

XP Professional x64 Edition (SP2)

Intel® Pentium® 4 - 2 GHz or faster,
Intel® Xeon™, Intel® Core™, AMD®

Athlon™ 64, AMD® Opteron™ or later

2 or more GB

Recommended System Requirements | 17

For large assembly design (more than
1,000 parts)

Windows® 7 64-bit
Windows® Vista™ 64-bit (SP2)

Windows® XP Professional x64 Edition
(SP2)

AMD64 or Intel® 64 processor

6 or more GB



Graphics Card

Microsoft Direct3D 10, Direct3D 9 CAD workstation-capable
capable

Other Requirements:

16 GB free disk space to accommodate the installation files and temporary
files created during the installation.

DVD-ROM drive

Microsoft Mouse compliant pointing device

1280 x 1024 or higher screen resolution

Internet connection for Web downloads and Subscription Aware access

Adobe Flash Player 10. Note: The multimedia learning components of the
Inventor Help system, such as the Ribbon Introduction, Command Locator,
and Show Me animations require Adobe Flash Player 10 be installed. If it
is not already installed, you can download it from
http://www.adobe.com/products/flashplayer/

Microsoft Internet Explorer 6.x through 8

Microsoft Excel 2003 through 2007 for iComponents, thread customization,
and spreadsheet-driven designs

Notes:
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Autodesk Inventor 2011 and AutoCAD Mechanical 2011 applications are
each provided both as 32-bit applications and as 64-bit applications for
installation and use on the corresponding operating system only. Autodesk
Vault Explorer 2011 is a 32-bit application for installation and use on either
a 32-bit or 64-bit operating system.

Autodesk Inventor 2011/AutoCAD Mechanical design applications and
Autodesk Vault must all be the same language on a given computer. English
versions of these applications run on any language operating system. Other
language versions of these applications run on operating systems of that
same language.

Autodesk Inventor 2011 has been optimized to take advantage of the SSE2
extended instruction sets supported on Pentium 4, AMD Athlon 64 and
AMD Opteron processors. Autodesk Inventor will not install on computers
that do not support SSE2. Several utilities are available on the internet that
report CPUID including supported instructions sets.
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B Autodesk recommends settings which allow Microsoft Windows to manage
virtual memory, as needed. There should always be at least twice as much
free hard disk space as system memory (RAM).

B Please refer to the Autodesk published graphics card information at:
Autodesk Inventor Hardware Web Site

B Autodesk Inventor 2011 is available only on DVD media (or electronic
download in some situations). CD media is no longer available. DVD-ROM
drive is not required if installing using electronic download.,

NOTE The preceding requirements are recommended for effective use of Autodesk
Inventor 2011 software. For further details, please refer to the Readme document
installed with Autodesk Inventor 2011.

For Macintosh Users: See the following table for hardware and software
requirements.

Boot Camp

You can install Autodesk® Inventor® Professional software on a Mac® computer
on a Windows partition. The system must use Boot Camp® to manage a dual
OS configuration and meet the minimum system requirements:

m Apple OS X 10.5x
B Boot Camp V 2.0 or highter

m Intel-based Mac (64-bit Windows Vista requires an Intel Core® 2 duo or
Xeon® processor)

B Minimum 3 GB RAM (Recommend 4 GB for 32-bit Windows OS, 8 GB or
more for 64-bit Windows OS)

B Minimum 20 GB disk space for Apple OS partition, minimum 20 GB for
Windows OS partition
Mac Virtualization on Parallels Desktop

Autodesk Inventor Professional can be used on the Mac via Parallels Desktop
for Mac without having to boot directly into the Windows OS so it is easy to
switch between platforms. The system must meet the following requirements:

B Mac os X 10.5x
B Parallels Desktop 4.0 (4.0.3844 or highter) or Desktop 5.0
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B Intel based Mac (64-bit Windows Vista requires an Intel Core 2 duo or
Xeon processor)

B Minimum 4 GB RAM (6 GB system memory for 32-bit Windows OS, 8 GB
or more for 64-bit Windows OS recommended)

B Minimum 40 GB available disk space (100 GB recommended)

For more details, please read the Inventor for Mac FAQ Inventor for Mac FAQ.

To find out if a service pack is available, visit the Autodesk Product Support page

Define Your Installation Method

Your license dictates which installation you use: Network or Stand-alone.

Network Installation

The selection of Network leads you down the path for network and multi-seat
stand-alone installation. It requires that you specify a license server model:

m Single license server

B Distributed license server

B Redundant license server

You can access design data locally or from a central server drive. The process

is to modify the design data content to meet your needs, and then serve it to
Standalone/MSSA/Network networked machines.

Stand-alone license

The selection of Stand-alone leads you down the path for an installation that
runs an Autodesk product on a single workstation.

For more information about installation methods, see License Types and Usage
on page 3.

Install Network Licenses

With a network license, the program is installed on workstations with the
required files and registry entries. A defined location of the Network License
Manager provides access to the licenses.

20 | Chapter 5 Installation Process


http://images.autodesk.com/adsk/files/autodesk_inventor_on_the_macintosh_faq.pdf
http://support.autodesk.com

Uninstall any previous versions of the Deployment Wizard before you use the
AutoCAD® 2011 Deployment Wizard. You cannot use an older version of the
Deployment Wizard to create deployments of currently released programs.
You cannot use the AutoCAD 2011 Deployment Wizard to create deployments
for previous versions of the product.

Installing Multi-seat Stand-alone Licenses

The multi-seat stand-alone license configuration is available with a network
license. When prompted in the Installation wizard, you choose the option
Network, and then use the deployment shortcut to install the products to all
the other systems.

Install Stand-alone Licenses

Stand-alone products require that you install the program individually on
each workstation.

You can use your Autodesk product for up to 30 days before you are required
to activate it. You can also activate your license at any time before the
expiration date. After the expiration date, you cannot run your Autodesk
product until you register and activate the product.

Moving Stand-alone Licenses

You can use the Portable License Utility to move a single Autodesk product
stand-alone license to more than one computer without purchasing a separate
license.

Manage Design Data

The Design Data folder provides a way for administrators to manage content.
Many of the design-specific files, such as the styles, thread, and so on, are
installed here.

The location of the Design Data folder is by default:
B For Windows XP, Program Files/Autodesk /Inventor [version]/Design Data

B For Windows Vista, Users/Public/Documents/Autodesk-Inventor [version]/Design
Data
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You can relocate either Design Data folder to a network location so that all
designers can automatically get file edits made in this location. You can define
different network locations on either a per-project basis or application wide.

NOTE The Design data folder you point to must contain a copy of all the files in
the originally installed location. The Autodesk Inventor 2011 software checks to
verify that all files are present upon a change in the location.

Autodesk Inventor 2011 allows an incomplete Design Data folder for legacy
and Pack and Go projects. Autodesk Inventor 2011 locates the missing files
in the default legacy install location, or provides a prompt to browse for them
in some circumstances.

Following a network deployment, alert the users that:
B This data is shared on the network.

B Edits to local copies of the shared data affect the local behavior only if the
local installation points to the local copy of the data.

To change the location of the Design Data folder application wide

Edit the “Design Data (Styles, and so on)” option in the Application Options
dialog box, Files tab.

1 Tools » Application Options, and then click the Files tab.

2 In the Design Data (Styles, and so on) text box, enter the UNC path to
the network location. Alternatively, click the browse button to locate and
specify the path.

3 Click OK.

To change the location of the Design Data folder for a project

Edit the “Design Data (Styles, and so on)” option in the Projects dialog box.
1 File » Projects.
2 Select the Project you want to edit.

3 Expand the Folder Options folder. Right-click Design Data (Styles, and so
on) and select Edit.

4 In the text box enter the UNC path to the network location, or click the
browse button to locate and specify the path.

5 Click Save.
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To revert back to the default content of the Design Data folder
1 In the Design Data folder, unzip the file called DesignData.exe.

2 Overwrite the existing .xml/ files.

Other Sources of Information

For more information about system requirements, on the Web go to
http://usa.autodesk.com/adsk/serviet/pc/index?sitelD=123112&id=13727144.
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Upgrades

Before you start your upgrade to Autodesk® Inventor® 2011, take the time to understand:

The importance of backing up your data

Migrating data

Custom settings, such as Inventor versus AutoCAD
UI configuration options

Content Center migration versus side-by-side

Upgrade from Previous Versions

Upgrading is the path you must take to obtain access to the new features and
improvements incorporated in the new release. An upgrade is the complete set
of steps required to move your engineering operations to the new release. It is
not just the process of installing the software. Like any other process that
involves change, it presents challenges and requires careful planning to minimize
the impact on your operations.

There are three components to the upgrade process:
B Backing up and migrating data
B Installing the new software

B User training
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Back Up Your Data

It is critical that you make a backup copy of your data before you start the
migration process. If you encounter a problem during the migration process,
a backup copy guarantees that you can recover your data.

For detailed information, see “Backing Up Vault Data” in the Autodesk Vault
2011 Implementation Guide on your product media.

Migrate Your Data

Migration is the process of converting your existing data to the formats used
by Autodesk Inventor 2011. We modify the internal format of Autodesk
Inventor files, sometimes referred to as the schema, to support the new features.

Autodesk Inventor 2011 and later incorporates changes to the File Open
command, which reduces the need to migrate data in some circumstances.
Unlike previous versions, the Open command does not automatically migrate
files from eatrlier versions, reducing the time required to open these files. The
migration is delayed until you change or save the file.

While this feature enables faster viewing, it is still advisable to migrate projects
that are still in active development, and therefore changing. The 3D models
that you create with Autodesk Inventor consist of a hierarchy of files. It is
important that you start the migration with the files that are used by other
files. We recommend that you migrate files in the sequence shown in the
following illustration.

Migration Sequence

BACKUP ALL DATA

{

Migrate Templates

V

Migrate Styles Library

'

Migrate Parts & Assemblies
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You can control the sequence manually, but it is easier to use the Migrate Files
utility built into the Inventor Task Scheduler.

Migration Plan

If you have a large volume of active engineering data, consider dividing the
process up into smaller phases. Your reseller can help you select the most
appropriate strategy for your specific situation.

Migrate Content Center

The Content Center contains the data required to insert standard parts into
your designs. Migrate this information before you try to use it with the new
version of Autodesk Inventor.

The Content Center in Autodesk Inventor uses the Autodesk® Vault server as
the data storage technology for all standard content. It is the common data
storage mechanism for Autodesk® Vault products and other Autodesk
applications.

There are several points to consider before you install the vault server and
migrate the data:

B If you upgrade from Autodesk Inventor 2010 to Autodesk Inventor 2011,
upgrade the data management server 2010. This server is required for
Inventor 2011 Content Center. The database remains installed so you can
migrate the data into the new version.

NOTE It is critical that you make a backup copy of your data before you
uninstall the Vault server.

B At the end of the Vault server upgrade, you are prompted to start the data
management server console. If you click the default value for the prompt
Yes, it launches the server console when installation of Autodesk Inventor
2011 is completed.

B The first time the server console starts, it looks for existing data
management server databases for migration. The data management server
database, with all the Autodesk Inventor 2010 and user Content Center
libraries, is located and submitted for migration. The options available for
migrating libraries vary, according to the versions of Inventor and the data
management server involved.
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B [tisimportant to differentiate between read-only Inventor standard content
libraries and user read/write libraries.

B The library migration is necessary before libraries are available for Content
Center.

B Once libraries are migrated and Content Center (CC) can consume them,
then CC requests an update of user read/write libraries. The CC Update
tool takes care of the CC data being correct for the new Inventor version.

B If you upgrade from version 2010 to Inventor 2011, keep the version 2010
standard content libraries until the update is finished. Then remove them
manually.

Test Migration

With your data safely backed up, we recommend that you perform a test
migration on a small set of data. Make a copy of a small project or a
subassembly of a larger project, and then execute the migration. You can
identify any potential problems and calibrate your environment to predict
how much time is going to be required to complete the migration.

Vault Migration

The data management console can migrate a vault from one release to another
by migrating in place or migrating through a temporary vault. As in any
migration, the first step is to back up vault data.

Tips about migrating vaults

B You can upgrade Vault 2011 only from Vault 2009, and 2010. If you
upgrade from a version older than 2009, migrate to 2009 or 2010 first, and
then migrate to 2011.

B You can migrate an Autodesk® Manufacturing Vault to Autodesk Vault

Professional only.

For detailed information about Vault migration, back ups, and restoring vaults
from backups, see the Autodesk Vault 2011 Implementation Guide on your product
media.
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Other Sources of Information

For more information about migrating data, see the white papers located on
the Autodesk Inventor product media.

For more information about migrating with Vault, see the Autodesk Vault 2011
Implementation Guide located on the product media.

For information about how installations of new versions of Autodesk Inventor
and the vault server affect Content Center, refer to the white papers on the
product media:

B Content Center for Inventor 2011 Side-by-side Installation

W Autodesk Inventor 2011 Content Center Installation Guide

If you have any doubts about the steps involved or the right process to use at
your site, contact your reseller before you go any further.
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Register and Activate
Products

Only one registration process is required to activate all your Autodesk® Inventor® software
products with standalone installations. The first time you enter your registration settings,
you create a single user ID and password. Then you can enter the user ID and your password
to activate each product the first time you launch it.

Your user ID is also used for access to the Subscription Center.

Check Product Information

You can view detailed information about your Autodesk® product and your
product license (such as the license usage type and the license behavior). You
can then save this information as a text file.

License usage types include:
B Commercial To license a product that was purchased commercially.

B Educational (EDU) Institution A license designed specifically for educational
institutions.

B Not for Resale To license a product that is not sold commercially.

B Student Version To license products for students who are using an Autodesk
product as part of their curriculum.

W Trial A temporary license that allows individuals to try the product. This
license expires after a predefined period.
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License behaviors include:

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time.
The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited
time. The term cannot be extended.

To view product information

1
2
3

On the Help menu, click About.
In the About (Autodesk product) window, click Product Information.

In the Product License Information dialog box, view details about your
product and the product license. When you are finished, click Close.

Click OK.

To save license information as a text file

HOWN

Activate

On the Help menu, click About [Autodesk product].
In the About [Autodesk product] window, click Product Information.
In the Product Information dialog box, click Save As.

In Save As dialog box, .txt is the default file type. Enter a file name and
choose a location where you want to save the file, and then click Save

In the Product License Information dialog box, click Close.
Click OK.

Autodesk Products

You can activate your Autodesk product with a standalone installation either
when you start the program. Alternatively, use the Help » About menu while
you are running the product.

To
1
2
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activate Autodesk products from the Help menu
On the Help menu, click About JAutodesk product].

In the About [Autodesk product] window, click Product Information.
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In the Product Information dialog box, click Activate.

In the Autodesk Product Licensing dialog box, Product License Activation
window, select Activate, and then click Next

On the Register Today page, follow the on-screen instructions.
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